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About the VRS Recording System

The VRS Recording System is multiple channel automatic audio recording software for Windows.

Typical Applications

Telephone line recording

Radio station program logging

Radio communication recording

Control room voice communication logging
Remote conference or other voice recording
Remote monitoring of telephone recording
Other specialized applications

VRS is designed to record 1 - 32 independent channels and processes and stores each channel
separately. For a recorder that is more suited to recording many microphones in the same room
in @ combined synchronous form you should consider using the MSRS Multichannel (Synchronous)
Recorder at www.nch.com.au/msrs/index. html.

VRS Features

Record up to 32 audio channels simultaneously on one PC.

Automatic voice activated, hardware port control or continuous recording modes.

Date-time scheduling (eg. record at set times of day or days of week).

RemoteMonitor to listen to remote recording live over a network or internet with TCP/IP
streaming.

Signal processing including automatic level control, high pass filters, hum filters and more.
Advanced audio compression with selectable codec to reduce file size. Supported file formats
include wav, mp3 and gsm with many other codecs including G711, CELP, Truespeech and
more.

Find and play recordings ordered by date and channel or from other computers on the local
area network.

[Phone Recorder Mode Only] Logs dialed numbers (DTMF) and if you have a modem that
supports caller ID, VRS can also log the caller's names and phone numbers.

[Phone Recorder Mode Only] Ability to calculate, display and log outbound call cost estimates
for auditing.

Mirror recordings to backup drive(s).

Automatic upload of recordings to FTP server for web or internet access.

Automatically send recordings to an email address in the background.

VRS Remote Control can start and stop recording from other workstations on the network.
Includes an API and SDK so your third party programs can control VRS recording (see
www.nch.com.auy/vrs/sdk.html). Plus VRS can be set to run other programs for special file
processing.

Audio Hardware

Audlio Connection

Audio for VRS can be from the following sound devices:

The standard computer sound in (1 channel only). Just plug the audio source in.

The standard computer sound in split to 2 mono channels. Buy a simple Y cable from your
local electronics to wire 2 mono sockets to a stereo plug. Then using Channel Properties
assign one channel to "left mono" and the other to "right mono".

Multiple sound cards in one PC. Depending on slots and resources you can install up to 3



sound cards in one PC. Each stereo input can be split (ie. a total of 6 inputs). This requires a
bit more technical work than a multichannel card (next).

e Multiple channel sound cards. There are many multichannel sound cards on the market today
- see www.nch.com.auyvrs/acc/index.htm/to find links. VRS can be setup to use these
channels. You can probably also install multiple devices to get more channels (check with the
manufacturer first).

» USB sound devices. USB devices usually can be used with a hub to connect many devices to
one PC. Most modern USB sound devices let you do this (but check with the manufacturer
before purchasing). Stereo devices can be split (see above).

¢ Professional Telephony Boards [for Call Recording]. Professional telephony boards including
CallURL and CAHTA be used directly. They can usually be purchased in 2/4/8 line versions
and many can be installed in one PC. They also have the advantage of allowing caller ID and
hardware control. See www.nch.com.au/hardware/telephony.htm/ for more information.

The noticeable exception is that VRS does not record through voice modems. For that you need
the TRx recording software (see TRx Manual Call Recorder at www.nch.com.au/trx/index.html).

Telephone Call Recording
For recording telephony calls you should either:

» Telephone Interface Connectors for each line. In USA or Canada, Radio Shack (Tandy) supply
a FCC approved unit for $US22 (cat no. 43-228A or 43-1236). But there are many better
quality units available. You can also order these types of connectors online using the links
from www.nch.com.au/hardware/callrec.html.

¢ A Professional Telephony Board (multiline). Both CallURL and CAHTA make these in 2/4/8
and more line version. See www.nch.com.au/haradware/telephony.html. The boards cost more
but include multichannel sound, caller ID, hardware control and telephone connection in one
turn-key unit.

If you are using VRS to record telephone lines, you should compare TRx Personal Call Recorder at
www.nch.com.au/trx/index.html. The difference with the TRx call recording manual (where the
user must start recording manually) is that VRS automatically records. TRx only records a single
line where VRS records up to 32. TRx uses a voice modem rather than a telephony card.

For more information about technical setup please refer to Options.

To use the software you must purchase a licence for each installation at a specified location
(address) where the software will be used. For more information about purchasing a registration,
please visit www.nch.com.auy/vrs/register/index.htmli.

If you need to transcribe recordings made by VRS, we recommend you download Express Scribe
(free) from www.nch.com.au/scribe/index.html. 1t is playback software designed specifically for
transcription work including variable speed playback, hot-key or foot pedal control and more.

A Sound File Editor and Sound File Converter are also available free from
www.nch.com.au/wavepad/index.htm/ and www.nch.com.au/switch/index.htm/ if you require.

VRS is part of the NCH Swift Sound suite of Business Audio Software. For more information
including free downloads, please see www.nch.com.au/software/index.htmi.



Getting Started with VRS

If you are new to the VRS Recording System you should refer to this manual to understand how
to setup the software correctly. You can also press the F1 key at just about any time while using
VRS to view context sensitive help about the screen you are looking at.

VRS has been pre-configured to have one channel voice-activated with your default sound device.
This channel can be setup in 5 different control modes: continuous, manual, voice activated and
telephony or hardware device control. Please note that for the VRS Basic (1 channel) and VRS
Lite (1 - 3 channels) license classes, voice-activated recording is the only control mode available.

You can setup VoIP lines by selecting Add Virtual Audio Sources (VoIP) in Options - Channels.
You can also download the free virtual PBX server Axon (see www.nch.com.au/pbx/index.htm/)
that will automatically set up 10 lines for VRS to record.

For additional hardware, including sound cards and (if required) hardware controllers or (for
phone recording) telephone adapters, you should review www.nch.com.au/vrs/acc/index.html.
That web page has the most up-to-date model recommendations, comments and pointers to
where you can purchase.

If you have any problems when using VRS and the Help Manual does not assist, technical support
is available online at www.nch.com.au/vrs/support.htm/. That page lists solutions to common
problems and gives the contact details of NCH Swift Sound technical support.

After you have tested the software, under the license terms you must purchase a registration for
each installation. If you have already purchased, select Register Software from the File menu and
enter your licence registration and activation code. If not, you can purchase with a credit card
online at www.nch.com.auy/vrs/register/index.html.



Options

To open the Options window, select Settings - Options from the menu bar, or click the
<Options> button below the menu bar on the VRS main window.

~ General

~ Channels
~ Recordings
~ Transmit
~ Database



Options ~ General
Run VRS automatically on Startup

VRS can be set to run automatically when the computer starts. To enable or disable this, check
(tick) or uncheck the "Run VRS automatically on Startup" option.

There are many modes of running automatically which you can select in the pull down list.

If you want VRS to run always, irrespective of whether anyone is logged on, select one of the
"Run As Service" options. When running as a service VRS will record before logon and after log
off.

By default when running as a service VRS will 'show' and be accessible to all users as an icon on
the tray of task bar. You can change this to limit it to the current user or no users. If you plan to
use Windows Terminal or Remote Desktop you probably should restrict VRS to a local user or no
users because 'showing' on a remote desktop can sometimes knock out local sound devices
because they attempt to use the remote devices!

Running automatically as a service only takes effect the next time you restart the PC. Therefore
you should confirm that it works after restarting your computer. If you have any problems check
any folders are accessible from the "Local System" account.

Display Icon on Tray of the Task Bar

VRS will usually appear as an icon on the Tray on the Taskbar. To hide the VRS icon (and the
splash screen), uncheck the "Display Tray Icon" box.

Allow others to listen live with RemoteMonitor

When this option is enable you can listen to any recording live over your network on the internet
with the RemoteMonitor program. Download RemoteMonitor by following the links on
www.nch.com.auy/vrs/index.html.

To restrict those who can listen add a user name or password. If you do this, the user of
RemoteMonitor will need the same UserName and Password to be able to connect to VRS.

When this feature is enable VRS listens for TCP connections on port 264. If VRS is running behind
a Firewall or NAT Gateway device you must set it to allow connections on that port (and redirect
connection to that computer). If you do not know how to do this, speak to your network
administrator.

Allow network control with VRS Remote Control

If you are running VRS on a central server you can start and stop recording on particular
channels from other workstations on the network using VRS Remote Control. To enable this
feature tick this option enter a user name and password and install VRS Remote Control on each
other workstation. More information is available on the Help Pages of VRS Remote Control.

Download VRS Remote Control from www.nch.com.au/vrs/vrc.html.



Enable Web Control Panel

VRS has a web control panel which, if enabled, lets you log onto VRS using any ordinary web
browser over your network or even the internet (if you set your firewall to allow it). After you log
in with your username and password you can search for, play or download recordings directly.
This is perfect if VRS is running on a remote computer.

To access the VRS Web Control Panel, tick the "Enable web control..." option and enter a user
name and password.

To offer the control panel VRS runs as a mini web server. It runs on port 81 (the normal port is
80 but VRS does not use this in case you have another web server on the same computer).

To access the VRS Web Control Panel use one of the following address formats in your browser:

http://localhost:port (if VRS is running on this computer)
eg. http://localhost:81

http://computername:port (for use on a local computer network)
eg. http://mycomputer:81

http://privateip:port (for use on a local computer network)
eg. http://192.168.0.1:81

http://publicip:port (for internet use)
eg. http://212.137.22.14:81

http://domainname:port (advanced option - if you have a DNS)
eg. http://vrs.mycompany.com:81

You need to make sure your firewall is not blocking the port (default port 81). Refer to your
firewall settings to check the correct TCP/IP port is opened.

Speak to your network administrator about any networking problems you have. They can usually
quickly fix routing or firewall problems.



Options ~ Channels
Record Channels

VRS can record 1 to 32 channels. These inputs could be you from your standard sound device,
additional sound cards installed in your computer or to the USB port, multi-channel sound cards
or devices, or a professional telephony board.

When using ordinary stereo sound inputs VRS lets you split and record with the left and right
channels as separate mono sources. This way a standard stereo input could be used to record 2
audio input sources. To split 2 mono inputs into one stereo input you will need a Y cable - ask at
your local electronics store.

To change the number of channels or lines to record, use the Add or Remove buttons. To setup
the channel, click on the "Properties" button or double click on the line.

See Channel Properties for more information about channel setup. The channel properties are
important and should not be skipped.

Hardware record sample rate

This is the sample rate that VRS uses to input audio from the sound card(s). Check the
documentation of your sound card for supported sample rates.

By default if you are using an audio compression codec (see the Recording tab) that sample rate
will be used. This is the rate set when you set the wav file codec, or 8000 if you select GSM. If
you select mp3, we recommend you specify a hardware sample rate.

For telephone recording or basic voice logging the recommended sample rate is 8000 (if your
sound device supports it).

Virtual Audio Sources (VoIP)

VRS can also record from other audio sources that are from other computers on the network (or
even over the Internet).

This can be used for a number of different applications. It is most often used with the Express
Talk SIP Softphone to record the VoIP calls. See www.nch.com.auy/talk/index.htm/ for more
information. Express Talk v 1.01 or later is required.

Run Server on TCP/IP Port
This port must be the same as specified in all the source software. By default it is 4080 and you

should leave it as that unless something else on this computer needs to use that port. You must
open that port with your firewall to allow connections.



Options ~ Recordings

Recording Options

Record file name format

You can select the file name format used by the VRS for audio files. Since recordings are usually
displayed in file-name order, if you will usually want to search for a file by line then date select
the file name accordingly.

Maximum record file length (file break time)

When VRS is recording long or continuous files it needs to break the recording into separate files.
The default value is 60mins which is suitable for most logging applications.

If you are emailing of uploading files and want a quicker turnaround you can reduce this. Take
care not to use too short times when recording continuously otherwise the number of files can
increase rapidly.

File overiap time (after break time)

When a long recording 'breaks' to a new file, VRS can use a preset overlap time when the original
and the new record file are both recording. This can be used to ensure that the voice at the break
time may be easily transcribed. Only a few seconds should be necessary for this.

Align recording break times with time-of-day

If this option is checked (ticked), VRS attempts to align the recording break times to the time of
day. For example, if you have a 60min maximum record time, VRS will attempt to break each file
on the hour (rather than exactly 60mins from the start of recording).

Note that when this option is enabled the actual file length might not be exactly the record file
length because VRS attempts to align the recordings to the time of day.

If this option is disabled, VRS breaks the file at the exact maximum record file length.

Prompt for Recording Data on start (manual recording only)

When recording is prompted manually, if this option is checked (ticked), VRS will prompt the user
for additional text data (eg. a file number). This data is then logged with the recording and can
be viewed and searched using Find & Play.

Stop Recording during Find & Play

When checked (ticked), recording is stopped when you open the Find & Play tool. This option is
required if your sound card is not duplex (ie. it cannot play while recording).

Reduce file size using audio compression

If this option is Checked (ticked), VRS will compress the recording to reduce storage or upload
requirements.

n"nm n

VRS currently supports the file formats ".wav", ".mp3" and ".gsm".



The Wave File Format ".wav" is a broad file type that supports multiple codecs within it. Click on
"Set Audio Compression Codec" to see the options. Make sure you select a mono codec if you are
recording mono from Channel Properties. See www.nch.com.au/acm/formats.htm/for a detailed
explanation of codecs. Please note the ".wav" file format can contain MPEG-Layer 3 or GSM6.10
encoded audio, so for example a gsm encoded file can be either ".gsm" or ".wav".

MPEG Layer-3 ".mp3" files are very popular for music storage and VRS supports it for logging
radio stations. You can select the bitrate using the "Set Audio Compression Codec". 128kbps is
high (for stereo music). 8kbs is the low end (for mono voice). It is not very good for low bitrate
voice encoding so we do not recommend mp3 for voice recordings.

GSM compression (".gsm" files) is commonly known because it is used for cell phone
transmission. It is not the smallest file size but it makes a good compromise between quality and
file size so we recommend it for phone and voice logging. Note: It always uses a 8000 sample
rate.

Audio Quality Options
Line Hum Reduction Filter

If you have a hum or buzz on recordings, VRS includes signal processing to reduce some of this.
Check the Line Hum Reduction box and enter the hum frequency. Usually hums are caused by
power supplies which are 60Hz (North America) or 50Hz (rest of the world). You must set the
hum frequency exactly for the hum reduction to work.

Hums are usually caused by cheap audio interface devices that have a low impedance
microphone output (or do not have sufficient balancing isolation) being used with cheap sound
cards that have poor high impedance microphone inputs. The ideal solution is to replace the
interface or include an impedance matching or balancing audio transformer. Line hum reduction
signal processing should only be used as the last option since it affects overall audio quality.
Customers have reported success with the Radio Shack Ground-Loop Isolator (270-054) which
can remove humes.

NOTE: Hum filtering places more demand on the CPU so do not use it if it is not necessary.

Low Frequency Cut Filter

Voice can have a high proportion of its energy in the low frequency bands that do not add much
to voice intelligibility but can make the voice sound 'muddy' particularly when using audio

compression (see below).

Turning on the low frequency filter with a low cut frequency of between 100 and 600Hz will make
the voice sound less muddy (but 'thinner") which can improve the recording.

NOTE: Low cut filtering places more demand on the CPU so do not use it if it is not necessary.
Use Automatic Gain Control

If the input level is not constant VRS can apply signal processing to regulate the recording
volume. For example, if you are recording telephone conversations but find the local and remote

volumes are very different.

NOTE: Automatic gain control places more demand on the CPU so do not use it if it is not



necessary.
Detect and Log DTMF Tones

Only use this if you are recording telephone calls. When selected, VRS will log the outward dialed
DTMF tones.

When DTMF tone detection is enabled you can also use VRS to create outbound call logs with
optional call cost estimates. Click on the "Log & Audit" button to set this up. See the Audit
Logging and Cost Estimates topic for more information.

If you have any false digits detected or misdetection you can adjust the DTMF detection settings.
Click on "DTMF Advanced Settings" and see DTMF Dial Digits Detection for more information.

Auto-Delete

Delete any file shorter than (seconds)

Sometimes recording may be started unnecessarily when a (substantive) recording is not made.
To save these files cluttering up your lists tick this option to set VRS to auto-delete the files if
they are shorter than the set length (default 5 seconds).

Auto-Delete (Days)

VRS will automatically delete recordings after a set number of days to stop the hard drive
becoming full. This can be between 1 and 800 days (over 2 years). To disable auto-delete, set it
to 0. VRS auto-deletes files in the default internal recordings folder and the specific line folders.

Logging MD5 Verification

To provide security against possible tampering with recordings after they have been made, when
this option is enabled VRS will log the MD5 checksum of each recording.



Options ~ Transmit
Send recordings by Email

If this option is selected, VRS will send all recordings to the specified email address as an
attachment to an email. This can be useful if you want to listen to recordings remotely.

VRS can send email in two ways. Click the <Email Settings> button and select the method you
wish to use:

Send using a SMTP Server

This is the process where the email is sent using a networked SMTP server. The SMTP server
usually is provided by your ISP. Its role is to relay emails for you. You do not require an installed
email client. You must enter the SMTP mailhost used by your ISP for sending of mail (ask them if
you do not know it) and your email return address.

If when using SMTP you receive an error message, it might be that your server requires an
authenticated login (a username and password) to send email. If this is the case, check (tick) the
“Server requires authentication” box and enter your User Name and Password in the boxes
provided.

Send directly to other side (work as own SMTP server)

When this option is selected the software sends the email directly to the remote persons email
address using a simple internal SMTP server. No outgoing server relays the email.

NOTE: An SMTP server option is preferred. The problem with the direct method is that if the
remote email server is down, email will fail. SMTP servers normally queue or spool mail for 12
hours.

Upload recordings via the Internet using FTP

If you have a FTP server or a website (with FTP access), select this option to make VRS upload all
recordings to your server. This can be useful for backup purposes or to make the recordings
available on the Internet (either public or private depending on your FTP server setup).

You must enter the FTP server (eg. ftp.yourdomain.com), your username, password and the
exact full folder into which you want the files uploaded (eg. /home/yoursite/www/recordings).

If you have any problems with the FTP setup, we strongly recommend you attempt to login
manually with FTP software (eg. WS_FTP, CuteFTP) to double check you have the correct full
path to the upload folder.

Mirror all recordings to this folder

If you have a backup drive, or want to backup all recordings over the network, you can use this
option.

NOTE: recordings are only transferred after recording and compression is complete.
Run external exe

This is an advanced option to allow IT professionals to add other transmit features to VRS - for
example, to use a proprietary codec or to insert the file in a database.



If this option is checked (ticked), after VRS has completed compressing the file it will run the
specified exe program. The program is usually a command-line program. The name of the file can
be sent as an argument using %s, which VRS replaces with the full path to the file. Remember to
include the full path to your exe (enclose it in "") and to enclose the %s in inverted commas too.

An example might be: "C:\Program Files\MyProgram\myexe" -myoptions "%s"

When you are running as a service your must consider the following:

Running as Local Service - Executables that have any form of display or input will fail in this
mode. This also includes command line applications that display a DOS Windows/Command
Window.

Running on a User Account - All executables should run correctly in this mode

Transmit Attempts Option

If email, ftp or network copy fails, VRS will wait a set time (default 600 seconds) and try again for
a set number of attempts (default 3). If it fails after this the file is abandoned.

You can change the wait time and number of attempts. In order to help you fix mistakes during
setup, VRS will automatically restart attempting any pending failed transmit after you close
Options.



Options ~ Database

Database and Table Selection

Log Recording Details to Database

If this option is selected, VRS will log information regarding each channel's recording to a
specified database. This can be useful if you want to keep a complete listing of each recording's

details for future reference.

To be able to select this option you will need to have an ODBC Data Source already created (see
following text).

Setting up an ODBC Data Source.
Go to Control Panel = Administrative Tools = Data Sources.

Under 'User DSN' Tab, Select 'Add' - Complete the Wizard by specifying a database driver, name
and location.

When you click Log Recording Details to Database in VRS, you should now see the Database
name you specified in Data Sources.

Database to Insert Into
Select from the Databases listed the one you wish to insert into.

If you database has a username and password specify these and test that your login details are
correct. You must be able to access the database and have a correct login in order to insert into
it.

SQL Command to INSERT
Specify what you require to be inserted into the database. An example insert statement follows:

INSERT INTO LogTable
("Date","Time","Channel","FileName","Folder","Duration","Data","MD5Value")
values
("%date%'’,'%time%','%channel%!','%filename%!’,'%folder%','%duration%’,'%dial/data%’,'%md
5%")
Where:
e the field or column names are : Date, Time,Channel... etc.
¢ the keywords that VRS uses include:

%date%, %time%,%channel%, %filename%,%folder%,%duration%,%dial/data%,%md5%

Extra columns/fields may be used to store further information such as UserName,
ComputerName, etc, providing a value instead of a keyword.

» To use your own fields please remember to place % around each other word you wish to
insert. eg: %MyComputer%

You can then test the SQL command for using the correct syntax and the correct field names.



NOTE: You need to be able to connect to the database to test this syntax as it inserts and then
removes the insertion in its test.

SQL INSERT Line Backup

If for some reason the Database file is not able to be accessed at any particular time, VRS will
store the SQL command and attempt to insert it at the end of the next recording.

Besides receiving a Log Error when it fails the first time, it is possible to check that the SQL
Commands are executed correctly by viewing the "C:\Documents and Settings\All
Users\Application Data\NCH Swift Sound\VRS\failedSQLCommands.txt".

If the file doesn't exist, all INSERT commands have been successful.

CSV Logging Options

Log Recording

Instead of Logging to a Database, or along with, it is possible to log your recordings to a Comma
Separated Value file.

This logging will not replace any lines in the selected file.
CSV files can then be read into Spreadsheets or used in conjunction with other files.

Simply specify the file name, (if it does not exist it will be created at the end of the next
recording).

CSV Line to INSERT
Specify what you require to be inserted into the CSV file. An example insertion line follows:

%date%,%time%,%channel%, %filename%,%folder%,%duration%, %dial/data%,%md5%,Com
puterl

e Keywords that VRS uses include:
%date%, %time%,%channel%, %filename%,%folder%,%duration%,%dial/data%,%md5%

Extra fields may be used to store further information such as : UserName, ComputerName, etc,
providing a value instead of a keyword.

* To use your own fields please remember to place % around each other word you wish to
insert. eg: %MyComputer%



Channel Properties

To set the properties for any channel, click Options = Channels, select the device then click the
<Properties> button.

Device Properties
Channel Name

This is the name of the channel or line that will be displayed on the main window and as part of
the file name when you Find and Play the recordings.

Record Device Options
Record Device
Select the sound input device to be used to record this channel in the pull down list.

You can use a single shared stereo device to record 2 mono channels by selecting the same
device for both channels but selecting Left for one channel and Right for the other. You might
need a Y cable from your local electronics store to connect 2 mono sockets to a stereo plug.

Record Input

The default record input channel is "Windows Record Mixer". A better option is to select the
required input channel which VRS will use directly. Usually this is "Line-In" or "Microphone",
depending on the socket used. If you select a channel you can adjust the input Record Volume.

Telephony Device for Caller-ID

This option only applies if you are using VRS to record phone calls, your phone network supports
caller ID and you have caller-id modem(s) or telephony boards in the computer. If all of the
above apply VRS can log the number (and name) of callers using the modem to decode the
incoming caller ID information. Tick this option and select the telephony device (CID supporting)
in the pull down list.

Record File Folder

By default, all recordings are recorded in the internal VRS Recordings folder on the primary drive
(C:\Documents and Settings\All Users\Application Data\NCH Swift Sound\VRS\Recordings).

You can override this by specifying a folder for any channel. This can be a single folder for all
channels or separate folders for each channel.

Note: Do not be tempted to set VRS to record directly over a LAN or network - this would mean
recording fails if the network fails (and the recording can use too much network bandwidth). If
you want a copy of recordings over the network use mirroring instead (with audio compression)
(see the Transmit tab of Options). That option means the files are compressed first and is fail-
safe if the network is down for a short time.

WARNING: If you have the Auto-delete recordings option enabled, take care to select
an empty folder - otherwise VRS will auto-delete all old files in the folder!



Stop/Start Properties
Record Start/Stop Control
Voice Activated Recording

If you select this option for a channel, VRS uses the input signal level to start and stop recording.
When the signal level is above the threshold (default -18dB), recording starts. When it drops
below the threshold level for more than the detect time (default: 12 seconds) recording stops.
This detect time is not used as a delay in starting the voice activated line.

If you find that the recording does not start, you may need to increase the device record volume.
If it does not stop, reduce the record volume. To adjust the record volume open the Windows
Record mixer or adjust the input channel volume.

Hardware Control/

If you select this option for a line, VRS recording is controlled by hardware connected to either a
game controller port or a serial (COM) port. If you are recording telephone lines, this could be the
Telephone Interface Device trigger.

If you are using a game port control device, a 4 button "Game Controller" device must be
enabled from the Windows control panel. For more information, please see Hardware
Connection.

Continuous Recording

If you select this option for a line, the line will be recorded continuously. A new file is created for
every hour so that you can easily locate a particular recording.

This option is usually used only where you want to record 24 hours a day. For example, radio
station program logging.

The file length is set from the Recordings tab of Options - "Maximum record file length".
Manual Recording

When this mode is selected, record can be started or stopped by clicking on the button
corresponding to the channel on the VRS main window. You can also use start or stop by right-
clicking on the NCH icon on the task bar tray and selecting the relevant channel.

This option must be selected if you want to let other programs control VRS using the Software
Development API (see www.nch.com.au/vrs/sdk.html).

Telephony Device Control

With a professional telephony device such as a CallURL or CAHTA telephony board (see
www.nch.com.auy/vrs/acc/index.html for info), VRS can use that device to detect if a phone line is
off-hook or not (in addition to obtaining caller ID information). This does not work on voice
modems. To use this option you must have the "Telephony Device for Caller-ID" ticked and
selected (see above).



Date-Time

You can set VRS to record only at certain times of day, week days and between commence and
expiration dates. To do this, check the Date-Time option and click on <Schedule Recordings>.
For more information see Date-Time Scheduling.

Recording Tones and Prompts
Play Device

If 'Recording Tone' or 'Recording Prompt' have been selected, then a sound output device will
need to be selected to play the audio for this channel. Simply select the device from the pull
down list.

The default play output channel is normally your sound device.
Play recording tone every [secs]

In some environments you are required to play a tone while recording. To do this, tick this box
and enter the number of seconds between tones.

Play ‘recording started’ prompt when recording starts

This option is usually only applicable when using VRS to record telephone calls with a professional
telephony board. If you tick this option and select the correct play device (corresponding to the
record device above) whenever recording is started a prompt will be played out the device.
You have three choices regarding the prompt options:

e you can choose to have no prompt played,

* you can use the default prompt (to hear it press <Play Prompt>),

e or you can use your own pre-recorded prompt; just locate the recorded mp3 file and

press <Play Prompt> to check that it is in the correct format.



Date-Time Scheduling

To setup Date-Time Scheduling, click on the <Schedule Recordings> button next to the Date-
7ime option on the Start/Stop Properties tab of Channel Properties.

When using Continuous Date-Time mode for a line, VRS records the line during any of one of a
list of Date-Time periods. The Date-Time periods can include a commence date, an expiration
date, time of day, and days of week and are managed using the Date-Time list.

Dates are in the format dd/mm/yy or mm/dd/yy depending on you computer regional settings.
Times are in the format hh:mm:ss.



Find and Play Recordings

Open the Find and Play Recordings dialog box using the menu File > Find and Play, or by clicking
the <Find & Play> button.

All recordings will be listed by date, time and line (the order can be changed by changing the file
name format using the Recordings tab of Options). The duration and dialed number (DTMF) will
also be displayed.

® Find & Play Recordings

Recordings
-

W H & X

Play Edit SavE Burn Backup  Transcribe  Delete Help

Fecording Diuration Type Dial # Data
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2006-11-16 158-18-07 Channel 1 0:00:11 WA
2006-11-16 158-53-55 Channel 1 000: 22 WEY
2006-11-16 16-01-22 Chanrel 1 0:00:57 e
2006-11-16 16-23-46 Chanrel 1 00014 way
2006-11-16 16-31-38 Channel 1 0:00:33 WA
2006-11-16 16-32-55 Channel 1 00015 e
2006-11-16 16-37-21 Chanrel 1 0:00:46 wavy
2006-11-16 16-45-12 Channel 1 o113 Way
2006-11-16 16-53-39 Channel 1 0:00: 37 Wa
2006-11-16 16-59-32 Channel 1 0:00: 26 e
2006-11-16 17-00-00 Chanrel 1 00228 way
2006-11-16 17-22-03 Chanrnel 1 00002 wav
2006-11-16 17-37-28 Channel 1 0:00: 23 _WEY
2006-11-16 17-40-28 Channel 1 0:00:11 e
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16 Recordings were Found

Playing a Recording

To play a recording select it and press <Play> or F9. When the Play Control Box opens you can
move back and forward within the recording using the left and right arrow keys. To move to the
beginning press Home. To move to the end press End. Press PgUp/PgDn for the previous or next
tracks respectively and Enter to end.



Edit Audio

This will open the selected recording in Wavepad, a full featured professional sound editor for
Windows. When editing audio files you can cut, copy and paste parts of recordings and, if
required, add effects like echo, amplification and noise reduction.

WavePad works as a wav editor or mp3 editor but it also supports a number of other file formats

including vox, gsm, real audio, au, aif, flac, ogg and more. The program is designed to be a very

easy and intuitive to use for audio editing. Within minutes you will be able to open or record a file
and edit it. But if you take time to explore the other features you will find many powerful tools for
editing audio designed with the professional sound engineer in mind.

Wavepad comes in two versions a free basic version and a masters edition. Downloading this
software will provide you with a free trial version.

Save As

To save a recording as a wav, mp3 or gsm file in a different location on your hard drive or to a
network folder, select the recording and click "Save As". On the Save Recording As window enter
the file name and location to save it in, then click the <Save> button.

Send to Email Now
The selected file will be attached to a default email and sent to the address you specify.
Burn to CD-ROM

The selected files will be imported into Express Burn. Express Burn is also the fastest CD/DVD
writing program in the world, using proprietary optimizing systems. It will also create an index file
which it will begin burning immediately to a Data CD.

Compress and Backup

File sizes getting to large or do you wish to ensure your have a backup of your audio? Compress
and Backup will provide you the choice of burning straight to a CD after compression or to a
Backup Folder. It can compress in 3 different formats. The choice of compression depends on the
particular audio settings that determined the quality of the sound file that was recorded. Please
test that the compression type is sufficient in size and quality of audio for a sample file.
Compressing and backing up does not effect your original audio recording.

Convert Sound File

Converts the audio file(s) to a different format using Switch. Switch audio file converter is very
easy to use. With the selected files added into Switch, select the format you want to use, and
then click the convert button. Switch supports converting to wav (PCM, ADPCM+, aLaw+, uLaw+,
and others), mp3, au, aif/aiff, gsm, vox, raw, ogg, flac, .rss, .amr+ and more.

Transcribe

Allow simple and easy dictation of files using Express Scribe. This computer transcriber
application features variable speed wave playback, foot pedal operation, file management and
more. This program is free, and may be downloaded from www.nch.com.au/scribe/index.html.

Deleting a Recording



To delete recordings, select them and click on the <Delete> button. You can select more than
one recording by holding down the Shift key while selecting.

Folder Tab

By default, Find and Play lists only recordings in the local record folder. You can change the
default folder for holding your audio files or you can change the alternative folder to suit your
needs.

If you want to play files over your local area network, install this program on the other computer
and point it to the folder that the Find and Play Window is referencing.

View Filter Tab

The View Filter Tab allows searching and filtering on what is displayed in the list view.
You can search or filter what is shown by the text in each column, by the duration of the audio or
by the date of the recording.

If you are using DTMF or caller ID logging (or other data), you can search for the recordings that
contain that data (eg. to or from a particular phone number). Tick the "Show only recordings
containing data" box, enter the data you are searching for and then click "Update Now".

Speech Search Tab

On the 'Speech Search' tab you can choose to search for keywords in the recordings. You must
select an installed Speech Recognition engine (eg. Dragon Naturally Speaking, IBM Via Voice).

Currently we only support engines that are compliant with SAPI 4.0 (not the later and current
version 5). Microsoft supplies a free 'Speech Command and Control' engine (filename actcnc.exe)
and this can be located using an internet search engine. Please note any speech engine used
must support Context Free Grammars. You can also optionally select a trained speaker for the
engine.

If multiple times are found on your speech search, clicking on the file will provide a list of the
"key found at" times. Speech searching places a bookmark to hold the place in the audio when
multiple times are found so you can jump to the keyword

Play Options Tab

Set the Sound Play Device you use to play your audio file, also set the Variable Speed Slow and
Variable Speed Fast that you can use to the vary the speed of playback.



Call Audit Logs & Cost Estimates

This topic is only applicable when VRS is being used to record telephone calls.

VRS can display and log information about each outgoing call including extension, dialed number
and call duration and can estimate the call cost according to a specified table. This information is
displayed immediately (in the status window) and is logged in a csv format file which can be
loaded by a database program (eg. Excel) for further analysis.

NOTE: In order for the necessary information about calls to be obtained for the logs, VRS must
be used with a professional telephony board. For more information about these devices please
refer to www.nch.com.au/hardware/telephony.htm/ on our website.

From the Recordings tab of Options, tick the option "Detect & Log DTMF tones". Click on the "Log
& Audit" button. When the "Call Logging & Audit Cost Estimator" box opens, tick "Use outbound
call logging and cost estimating”.

Display only call log & audit (suppress other system messages)

This option is used to clean up the status display. When this box is ticked normal status messages
(eg. "Recording Started...") will not be displayed. You should only tick this box if you will be
actively using VRS to display and note call costs. Otherwise, leave it unticked.

Number Pricing List

In order to estimate the cost of each call, VRS uses a table of starting dialed numbers with
corresponding cents-per-minute rates. You need to enter this table by clicking the "Add" button
then entering the starting digits and applicable rate.

VRS scans the list in the order that you enter them. Enter more specific values first (with more
digits) then follow with less specific values later.

If there is no corresponding entry VRS uses the "All other calls..." rate.
Operation

Once you have setup the Number Pricing List, at the end of each call VRS will display the channel
number, duration and cost estimate.

The information is also listed on the Call Audit Logs. To view or print the Call Audit Logs select
File > View or Print Logs - ... select log = View.

These Call Audit Logs are stored in comma delimited (csv) format which can be imported directly
into a database or spreadsheet program (eg. Excel). You can open these files in the C:\Program
Files\NCH Swift Sound\VRS\Logs folder. The fields are:

Date(YYYY-MM-DD)
CallStartTime(HH:MM:SS)
LocalExtensionChannel
Dialed Number
Duration(Secs)
CostEstimate($.cc)



Warning about the Limits of Cost Estimates

The cost estimates will always only be estimates. There is no way you will be able to enter a
table as complex as those used by your telephone company. VRS also does not allow for
different rates at different times of day.

Cost estimates are based on the full call duration irrespective of whether the call is answered
or not.

If you are using voice activated mode it is possible that one call immediately followed by
another without a sufficient hang-up time will be counted as one call. If this is a serious
problem, consider using a hardware connection.



Using Recording Logs and Data

Using the menu “File = View, Print or Open Data Logs" you open a folder containing the VRS
logs.

VRS logs a system log for each day. This shows every major event VRS performs. It is very useful
to see what happened at a particular time (particularly if something went wrong). For example, if
files were not transmitted properly you should see error messages on these system logs.

VRS also logs recording data as a csv file. These files can be viewed with Notepad or imported
into a database (eg. Excel) or other software for further analysis and searching. The data logged
is in comma separated form of "date,time,channelname,filename,duration,data".

The "data" field will include:

1.

2.
3.
4

any "Prompt for Recording Data on start" entered data if you have enabled this option on
Options > Recordings,

any data sent to VRS from other software using the VRS SDK,

any DTMF dial digits, and

caller ID, if supported.



Virtual Audio Sources (VoIP)

VRS normally runs with the audio connected to hardware in the computer on which it is running.
However VRS can also link to other computers on the network or internet to receive audio using
TCP/IP.

To do this you need software that will run as a source (eg. Express Talk VoIP Softphone -
www.nch.com.auy/talk/index.htm/). You also need to make sure the firewall allows TCP/IP
connections on the Virtual Audio Sources port (usually 4080).

You need to add each 'source' using the Channels tab of Options. When you click <Add> you will
be prompted for these properties:

Source Name
This is the channel name. It appears on the VRS Main Window and in the file names themselves.
Source Access Code

The access code is used to identify (and authenticate) sources. It should be something random -
long enough to be a password. No two lines must have the same access code.

Note: The same access code must be entered in the source software.
Number of Channels for this Source

Virtual Audio Sources can have multiple connections at the same time. Set the humber of channel
connections for the source here and VRS will configure that number of channels for the source.

NOTE: Remember that VRS licensing is based on the number of channels that are required to be
recorded by the software. If you set too many channels for a source you could exceed the total
number of recording channels permitted under your VRS license class.

Record File Folder

By default, all recordings are recorded in the internal VRS Recordings folder on the primary drive
(C:\Documents and Settings\All Users\Application Data\NCH Swift Sound\VRS\Recordings).

You can override this by specifying a folder for any channel. This can be a single folder for all
channels or separate folders for each channel.

NOTE: Do not be tempted to set VRS to record directly over a LAN or network - this would mean
recording fails if the network fails (and the recording can use too much network bandwidth). If
you want a copy of recordings over the network, use mirroring instead (with audio compression) -
see the Transmit tab of Options. That option means the files are compressed first and is fail-safe
if the network is down for a short time.

WARNING: If you have the auto-delete recordings option enabled, take care to select
an empty folder (otherwise VRS will auto-delete all old files in the folder!).



DTMF Dial Digits Detection

When running as a call recorder, VRS can log the digits dialed by the local caller. Enable this
using the option on the Recording tab of Options.

The default DTMF Detection Settings should work as-they-are for almost all cases. If however you
are getting digits missed or not detected you can click on the "DTMF Advanced Settings..." button
to change them.

Stop detecting digits after...

If a call is made outbound you normally only want to log the phone number which usually
happens in the first 10 seconds of the call. You do not want to log later digits (on say an IVR
system). So VRS is set to stop recording the digits after 15 seconds.

Detect sensitivity level

DTMF tone detection is a balance between detecting all the digits and miss-detecting false digits.
It depends on the quality and volume of the phone line. If you find you are getting digits missed
or have false digits you can adjust the setting here.

NOTE: If you find yourself increasing sensitivity it might just mean your input level is too soft.



Hardware Connection

Audio Connection

Audio for VRS can be from the following sound devices:

The standard computer sound in (1 channel only). Just plug the audio source in.

The standard computer sound in split to 2 mono channels. Buy a simple Y cable from your
local electronics to wire 2 mono sockets to a stereo plug. Then using Channel Properties
assign one channel to "left mono" and the other to "right mono".

Multiple sound cards in one PC. Depending on slots and resources you can install up to 3
sound cards in one PC. Each stereo input can be split (ie. a total of 6 inputs). This requires a
bit more technical work than a multichannel card (next).

Multiple-channel sound cards. There are many multichannel sound cards on the market today
see www.nch.com.auy/vrs/acc/index.htm/to find links. VRS can be setup to use these
channels. You can probably also install multiple devices to get more channels (check with the
manufacturer first).

USB sound devices. USB devices usually can be used with a hub to connect many devices to
one PC. Most modern USB sound devices let you do this (but check with the manufacturer
before purchasing). Stereo devices can be split (see above).

Professional Telephony Boards [for Call Recording]. Professional telephony boards including
CallURL and CAHTA can be used directly. They can usually be purchased in 2/4/8 line
versions and many can be installed in one PC. They also have the advantage of allowing
caller ID and hardware control. See www.nch.com.au/hardware/telephony.html for more
information.

The noticeable exception is VRS does not record through voice modems. For that you need the
TRX manual call recorder (see www.nch.com.au/trx/index.htmi).

Telephone Call Recording

For recording telephony calls you should either:

Telephone Interface Connectors (call recording adapters) for each line. In USA or Canada,
Radio Shack (Tandy) supply a FCC approved unit for $US22 (cat no. 43-228A or 43-1236).
But there are many better quality units available. You can also order these types of
connectors online using the links from www.nch.com.au/hardware/callrec. html.

A Professional Telephony Board (multiline). Both CallURL and CAHTA make these in 2/4/8
and more line versions. See www.nch.com.au/hardware/telephony.html. The boards cost
more but include multichannel sound, caller ID, hardware control and telephone connection in
one turn-key unit.

Hardware Record Control

If you are using VRS with specialist record devices (eg. professional Call Record Interface units),
your supplier may be able to provide a pre-made cable to connect between the device and the
(Game Controller - Joystick) port of the computer running VRS.

If you have connected the cable, and the VRS Settings Box reports that no device is connected,
you may need to enable a 4 button Game Device using the Windows Control Panel (under Game
Controllers).



Devices can also be connected to a COM port.

For each channel, you must select the correct port and connection that will be used to control
that line.

Technical Information

The following information is intended only for those who wish to create or link their own
equipment. It requires are good understanding of electronics, computer hardware and game
controller ports.

In order to trigger VRS in hardware mode, the hardware must connect the button switch for the
line. For line 1 this is button 1 of port 1. Line 2 is button 2 of port 1. Line 5 is button 1 of port 2
and so on. Your equipment must "press" (connect to ground) these buttons to start recording,
and disconnect when recording is to stop.

Important: The cable will also need to notify Windows that it is correctly connected. This can only
be done by connecting the x and y axis of all ports to the +5V pin (see the diagram below).

Before you will be able to use the port, you must have a 4 button Game Device enabled from the
Control Panel (under Game Controllers). A useful test is to connect a normal joystick and see if it
triggers recordings on hardware lines.

The connection diagram follows:

Game Controller Port Wiring:
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COM Port Wiring:

1 - CTS
2 - DSR
3 - RING
4 - RLSD



Password Options

VRS lets you restrict access to some functions and to require a password.

Use ‘File > Password Options’ to setup which VRS functions require a password. If you have
entered a password before you will need to enter the password before you can change password

settings.

Take care not to forget your password. The only way a password can be reset is by uninstalling
and reinstalling the software.

Password Options
Options

If ticked you need the password to open the Options dialog box. Use this option to prevent users
from changing settings.

Find and Play

If ticked the user will need to enter the password before being able to open the Find and Play
window to access prior recordings.

View Change

This lets you restrict a user's ability to change the view of the main window. With this option
enabled, without a password a user will not be able change how many lines are displayed by
selecting any of the compact, full or standard view options.

Delete Recordings

There may be a reason the administrator may wish to grant access to the Find and Play Window
but restrict the ability to delete any recordings. This now has a password check upon both toolbar
and menu items in this window.

Exit or Stop

If you Exit VRS recording stops. So tick this option to make 'Exit' password protected.



Trouble-Shooting Problems

Recording does not start
Recording does not stop
Recording is broken into smaller files

If you do not see the black VU meters moving on the main screen of VRS you might need to
manually select your sound record device. Go Options - General tab - Record Channel >
Properties and select the record device (sound card) to use for the channel from the pull down
list.

If you see the VU meters moving on the main screen of VRS but it still does not start recording
you may need to check your Record Start/Stop control mode for the channel. The Record
Start/Stop Control mode is set using the "Channels Properties Box" which you open using Options
- General tab - Record Channels = Properties.

If you are using Voice Activated Recording and recording never starts or chops off the ends,
reduce the "Voice Active Detect Level". If it is very (-24dB or lower) then you may have a record
volume problem (read below).

Record volume is very low

If the record volume is very low (which can also cause Voice Activated Recording mode to fail):

* Check you have setup the record volume to maximum. Go Options - General tab > Record
Channels - Properties > Open Windows Record Mixer and adjust the volume of the correct
input channel **,

» If you are using a 'microphone level' source, make sure you are plugged into the mic-in (not
line-in) socket on the sound card. If there is only one audio-in socket on the sound card, see
if the Windows Record Mixer has an Advanced option with +15dB or +20dB gain. If your
sound card only has a line input (and no microphone input) and you want to use a
microphone signal you may have to connect a microphone preamplifier.

** If Open Windows Record Mixer fails, it means your sound card drivers do not support the
windows mixer interface. This is rare with popular cards today but can happen with specialist
sound cards that provide their own mixer. The solution is that you need to manually open the
mixer software provided with the sound card.

You hear a hum or buzz on recordings

If you have a loud hum or buzz on recordings, VRS includes signal processing to reduce some of
this. Check the Line Hum Reduction box and enter the hum frequency. Usually hums are caused
by power supplies which are 60Hz (North America) or 50Hz (rest of the world). You must set the
hum frequency exactly for the hum reduction to work. Line hum reduction signal processing
should only be used as the last option since it affects overall audio quality.

It is much preferable to solve the hardware problem causing the hum or buzz. Hums are usually
caused by cheap audio interface devices that have a low impedance microphone output (or do
not have sufficient balancing isolation) being used with cheap sound cards that have poor high
impedance microphone inputs. The ideal solutions is to (a) replace the telephone interface, (b)
include an impedance matching or balancing audio transformer or (c) install a professional
microphone pre-amplifier between the interface and the line-in of the sound card. Speak to a
audio-technician in your local electronics store.



Customers have reported success with the Radio Shack Ground-Loop Isolator (270-054) which
can remove humes.

A large disparity in volumes

If there is a large disparity between different parts of the recordings, tick the "use automatic level
(gain) control" item from the Recordings tab of Options.

Sending recordings by email fails

If you have email problems when using Internal Simple SMTP:

Have you entered your ISP SMTP mailhost server correctly on the Transmit tab of Options?
To turn the startup splash screen off

You cannot turn the splash screen off alone but if you turn off "Display Tray Icon" the neither the
splash screen nor the tray icon will display.

You need an approved "Telephone Interface Unit"
In USA or Canada, Radio Shack (Tandy) supply a FCC approved unit for $US19.95 (cat no. 43-
228A or 43-1236). For interfaces for other countries and for the latest information about the

hardware and accessories for VRS consult www.nch.com.au/vrs/acc/index. htmi.

The telephone unit/adaptor described above must be connected correctly.
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This is just one of several different ways of connecting the system. The modem connection is for
an internal modem and is optional. It is not necessary to have a modem or an Internet
connection to run VRS.

For more information on setting up the telephone unit for VRS, please see Hardware
Connection.

Checking the telephone unit.



If the computer in the above diagram is replaced by a cassette recorder (or some similar device)
then the telephone conversations should be able to be recorded in a simple way. If there is no
sound coming through or if there is a hum accompanying the sound then there is a fault in the
unit or the way in which it is connected.

Audio files are too large

VRS is capable of compression audio files. You can select the audio compression format using
Options > Recordings - Select audio compression codec. For more information on compression
codecs, please visit www.nch.com.au/acmy/index.html.

Unrecognised File Format

If your computer will not recognise the file format when saving or retrieving you might need to
install a CODEC. The codecs are installed with Windows. If you chose not to install the "Audio
ACM Drivers" when you installed Windows, you can install them now by running the Windows
Install CD.

VRS Fails when using Windows Terminal or Remote Desktop
Make sure that the Run as mode (on the General tab of Options) is set so that the VRS does NOT

run on the remote users account. If running as a service select "No Users".

If none of the above solve your problem, please view the up-to-date VRS Online Technical
Support at www.nch.com.auy/vrs/support.htm/. If that does not solve your problem, you can
contact us using the technical support contacts listed on that page.



Purchase and Register the Software

VRS requires purchase and registration of a license for each installation of the software. You can
view current pricing information at www.nch.com.auy/vrsregister. Take care to select your license
class carefully, as many have restrictions on the number of lines used or choice of record modes.

After you purchase a software licence from us, you will receive two emails. One email is the
Invoice/Receipt, and the other Software Purchase email contains your full 11-digit licence serial
number and instructions on how to use this serial number to activate your software licence. This
is done by entering the licence serial number and your details at www.nch.com.au/activate on
our website. Alternatively, you can select File > Register Software from the VRS menu bar and
enter the license serial number into the ‘Step 2: Activate Serial Number’ section.

The licence registration and activation code details (Name - Location - ID - Key) will be displayed
on your browser window, and will also be automatically emailed to you.

Select File > Register Software from the VRS menu bar, and enter your registration details,
exactly as provided, into the ‘Step 3: Enter the license details’ section of the registration window:

Register Software YRS Recording System @E|

Step 1: Purchaze Online

To uze thiz software vou must purchaze a licence for each
inztallation of the software. [F pow haven't got one, pleaze click on
the below link to purchasze it.

Purchaze Licence

Step 2 Actieate Senal Mumber

After purchase, you need to activate vour serial number which iz zent
ko waw by email.

Serial Mumber:

Step 3 Enter the license details

Enter the registration detailz EXACT LY as they appear on activation
and zent by email.

Mame [or Buzsiness Mame]: ed.Joe Blogas

Location: eq.Ch Branch
YRS Recording System (D - eg 123456 | - |egudhfnekf

[ k. ] [ Cancel ][ Help

NOTE: When you receive the email containing the registration and activation code you should
heed the advice on that email and print out a copy of it immediately, and keep that hard copy in
a safe place.



If your key is not accepted...

1. Check you have entered the Name, Location, ID and Key exactly as they appear on the email
containing the license registration and activation code.

2. If the software license was purchased a while ago for a previous version of the software, the
license registration and activation code that you are using may not work with a more recent
version of VRS. In this case you must purchase an upgrade at www.nch.com.au/upgrade.

3. If your license registration and activation code has worked previously with the version of the
software that you are using, the Key from the code may simply require updating. Contact NCH
Technical Support using the email form at www.nch.com.au/support/regcontact.htm/ on the
website, and include the full details (Name - Location - ID - Key) of your code.



VRS Software Licence Terms

1.

The copyrights in this software and any audio or visual work distributed with the software
belong to NCH Swift Sound. NCH Swift Sound reserves all rights. NCH Swift Sound licences
the distribution and installation of this software only in accordance with these terms.

By installing, using or distributing this software you, on your own behalf and on behalf of
your employer or principal, agree to be bound by these terms. If you do not agree to any of
these terms, you may not use, copy, transmit, distribute, or install this software.

This software, and all accompanying files, data and materials, are distributed "as is" and with
no warranties of any kind, whether express or implied except as required by law. If you
intend to rely on this software for critical purposes, it is essential that you should test it fully
prior to using it for critical applications and you must assume the entire risk of using the
program.

NCH Swift Sound will not be liable for any loss arising out of the use of this software
including, but not limited to, any special, incidental or consequential loss. NCH Swift Sound
may not refund any amount paid for the purchase of the software to the purchaser of the
software unless the purchaser satisfies NCH Swift Sound that they tested the free version of
the software prior to purchase.

You may not use this software in any circumstances where there is any risk that failure of this
software might result in a physical injury or loss of life. Any such use by you is entirely at
your own risk, and you agree to indemnify NCH Swift Sound from any claims relating to such
unauthorized use.

You may copy or distribute the installation file of this software in its complete unaltered form
but you may not, under any circumstances, distribute any software registration code. In the
event that you do distribute a software registration code, you will be liable to pay the full
purchase price for each location where the unauthorised use of code occurs.

This software is free for evaluation use only. To use the software you must purchase
(register) a licence for each installation at a specified location (address) where the software
will be used.

The contract arising out of this agreement is governed by the laws and courts of the
Australian Capital Territory.
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